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Introduction

Introduction

DeltaServer offers a number of ways of controlling external devices, whether projectors, lighting,
stage and theatre effects machines, or playback devices including smart glasses, 3D synchronised
glasses and VR headsets.

See also: 7thConnect

A powerful, single application, used to connect multiple I/O feeds for use with Delta Media Server
system. Receive dynamic inputs to the Delta Timeline and send controls to switches over IP.

Ø 7thConnect User Guide 

http://portal.7thsense.one/user-guides/M171-7thconnect/
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Art-Net/DMX Control

Art-Net/DMX Control

DMX is a serial protocol used to control many lighting systems, bubble, and smoke machines and
other stage effects devices.

Art-Net is DMX over Ethernet, the protocol that DeltaServer uses to interface with external devices,
so we need to convert the Art-Net signal into DMX.

An Ethernet cable carries the Art-Net signal to and from a converter (e.g. Enttec box), which converts
to DMX over XLR cable to the first device: other DMX devices can then be connected in a serial /
daisy-chain format, one to the next.
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Art-Net/DMX Control

Addressing DMX Devices

Your devices receive messages from DeltaServer according to the DMX Base Address and their
respective Delta channels.

Each Base Address can be any number within range (0-511) but should be unique for independent
devices: it should not coincide with any other base/channel number unless this is the requirement
(e.g. multiple devices listening to the same part of the addressed block).

Plan your device requirements:

For example, Light 1 has base address of 1 and can have 4 Delta output channels: 

· Red channel 1 (values 0–255)

· Blue channel 2 (values 0–255)

· Green channel 3 (values 0–255)

· Brightness channel 4 (values 0–255)

Light 2 can then start at base address 5 and take up 4 channels, and so on.

Further instructions for addressing specific devices may be found in its manufacturer’s user
manual.

DIP switch settings

The example below shows a DIP switch chart denoting that this light is ON (switch 10) with a base
address of 5 (switches 1 and 3):
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Art-Net/DMX Control

A device set-up might look like this:

ArtNetominator is a free facility to help you to set up and troubleshoot your Art-Net devices:

http://www.lightjams.com/artnetominator/

http://www.lightjams.com/artnetominator/
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Art-Net/DMX Control

ENTTEC Node Management

This page describes the ENTTEC OpenDMX Ethernet (ODE) MkI. Operation of the MkII is the same,
but the software app for configuration (v1.8 on) operates in a browser page.

The server must be set up with the correct software for the DMX converter – we use ENTTEC Node
Management Utility.

· Connect the ENTTEC box to the server NIC (or via network) with an Ethernet cable.

· Connect the first device to the ENTTEC box using XLR cable.

· Connect each device to the next using XLR cables.

· Open the Node Management software.

· Click the ‘Discovery’ button:

The attached ENTECC box will show listed under Device Type with its IP Address, Device Name
and Mac Address.

· Click to select the device and the ‘Configure’ button will become active. Click it.
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Art-Net/DMX Control

· The correct details should default in, but you should check:

· IP Address is correct and is on the same range as the server (if it is on a different range, the
server can get confused and may show the device IP in its front panel instead of its own).

· Protocol: Art-Net

· Subnet and Universe can be set to what you want – the default for both is 00.
Check/set your Subnet and Universe here, and make sure they match in Delta.

· Port Direction: Output DMX
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Universes and Subnets

Each ENTTEC box is addressed to a Universe and Subnet (to allow for more physical channels if
required) on a network.

DeltaServer can read from up to 16 Universes (512 channels each), with up to 16 Subnets (512
channels each) for Art-Net INPUT via (for example) a Showtec console.

For Art-Net OUTPUT, DeltaServer outputs to a single Universe/Subnet as set in Preferences >
ArtNet & DMX.

Each independent output device (light, effects machine) should be addressed with a unique Base
Address + a Delta channel for each set of values it requires (e.g. R, G, B, Brightness for lights = 4
Delta Channels).

Each Delta device output can have a value of between 0 and 255 (8 bit) but this can be extended by
allocating 2 (16 bit) or 4 channels (32 bit) to match the device characteristics.

Some devices such as smoke or bubble machines only require a single Delta channel output: On =
255 and Off = 0.
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Art-Net/DMX Control

Configure Art-Net Output in DeltaGUI

Check the configuration in DeltaGUI matches your set-up. In DeltaGUI, select Configure > Preferences
and go to ‘ArtNet & DMX’. For the exact representation, see the Delta User Guide for your version on
our user portal.

Tick to enable ‘Output ArtNet Data’.

Check that the Art-Net NIC IP is the correct NIC to the Enttec box

Type in the correct Universe and SubNet for which Art-Net output should be enabled.

Note: if you tick ‘Enable TestMode’, Delta will send a message out to ALL channels available and so
all your devices should respond. Untick this box to stop/reset.

https://portal.7thsense.one/online-help/online_user_guides.html
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Art-Net/DMX Control

Create DeltaGUI Resource

Set up a new DeltaGUI resource for each of the devices you are using:

From the top menu bar in DeltaGUI, select View > ArtNet & DMX Editor:

Click Create New and name your resource. Click OK and select your new resource:
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Art-Net/DMX Control

· Set the Base Address to that of the device (i.e. the first channel number)

· Select between Instant, Fade or Tween where:

o Instant = immediate, single event within the chosen Tween Group

o Fade = values (e.g. light colours) will fade down from current setting (note should not be
mixed with other Instant or Tweened devices)

o Tween = values (e.g. light colours) will go between the previous and ‘this’ setting within the
chosen Tween Group

· Click ‘Add Slider’ to add each channel required for that device.

· Choose the Channel Count (1,2 or 4) for that slider and the Output Channel start. The Channel
Count allows the range to be expanded further for devices that support more than 8-bit; a single
channel can give values of 0–255 (8-bit) but 2 channels can give a range of 0–65535 (16-bit), 4
channels give a range of 0-4,294,967,295 (32-bit).

Name and Set Sliders

You can leave the Slider Names as their default names, or re-name them according to what they
relate to on the device. In this case, Light 1 has 4 channels, starting at Base Address 1:

· Red (output ch 1) 

· Green (output ch 2) 
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Art-Net/DMX Control

· Blue (output ch 3) and 

· Brightness (output ch 4)

RGB channels are usually consecutively numbered for most lights.

This light is set to switch on instantly to full (value 255) brightness and full green when it is triggered
in the timeline. Red and Blue are off (value 0). The grey sliders can also be dragged up or down with
the mouse.

A smoke or bubble machine would only have a single channel with values 255: On, 0:Off.

Some devices may behave in different ways, for example some lights have an uppermost limit of,
say, 210. If the slider goes above that limit it may tell the light to flash on-off, or to kill the output,
depending on device settings. This information should be found in the manufacturer’s user guide.
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Art-Net/DMX Control

Using Art-Net Timeline Resources

Once you have set up your resources they will appear in the resource pool, available to the timeline.
As with other resources, drag and drop them onto the timeline, then right-click to configure them with
the Resource Editor:

Before any Art-Net resources are placed on the timeline, all values for a DMX device are 0.

Whilst an Art-Net resource can have a Fade duration, it is essentially just a start trigger to change the
current status of a DMX device to another status, using resource properties. In the example above,
the Light2 resource is set to a fade; it is moved down in the layer because a fade can have
overlapping duration with other events.

Fade Effect

· The Fade effect fades to the colour selected over the set time.

· If you want to fade down to a colour, set the first instance to the colour that you want, then set
another instance with sliders at the new values.

Remember that Fade type Art-Net resources are not compatible with Tween or Instant, so do not use
a mix of Fade with any other type.

Tween Effect

The Tween effect will gradually change a light from the colour of the current instance to that of the
next:

If the first instance of Light1 is set to RGB 0, 255, 0 (green) and the next instance of Light1 is set to
RGB 132, 41, 187 (purple), it will transition smoothly from green to purple over the time separation
between the two resources on the timeline.
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Art-Net/DMX Control

All Tween and Instant type Art-Net resources can be placed in a Tween Group in order to separate
different tweening effects:
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Art-Net/DMX Control

Configure Art-Net Input in DeltaGUI

Delta can also receive Art-Net input values from an external source (for example a control desk),
which can be used to trigger real-time commands for media playback. These commands could be to
adjust media colour, position on screen, rotation or any other Delta sequence command. Input Art-Net
resources can be configured to any universe / subnet (up to 16 of each).

In DeltaGUI, select Configure > Preferences and go to ‘ArtNet & DMX’.

The values from the selected DMX channels are substituted into placeholders in order to create the
command string sent into Delta.

In the example shown, the sliders are named Red, Green, Blue – the values from these input channels
(4, 5, 6) replace the placeholder strings %Red %Green %Blue, so the command sent within Delta in this
example is:

Mediacolor mymedia 100 101 102
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Art-Net/DMX Control

This command will trigger real-time changes of the selected channels at any time: apply values to (for
example) colour, or rotation, of specific media resource, which will trigger as the control slider is
moved.

Note that you can also offset and scale the channel values using those edit boxes. The order of
execution is offset, then scale.

offset
add a fixed value every time to this input

scale
add a relative value every time to this input
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Art-Net/DMX Control

Art-Net Recording

For recording in Delta, see the Delta User Guide on recording generally.

Art-Net recording enables Art-Net inputs to be recorded and then rerun in simulation scenarios. This
may be useful in optimising inputs, or to allow inputs to be simulated as shows are developed.

To set up recording, click the red Record button on the timeline controls:

Select Art-Net Recording:

Start
first DMX channel to record

End
last DMX channel to record (recording includes all channels between Start and End)

Universe
Universe being recorded

https://portal.7thsense.one/user-guides/M384-delta2_7-user-guide/deltagui_recording.html
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Subnet
Art-Net Universe being recorded

Save as
the number of bytes which make up a data point to be recorded

Input Network
The IP from which the recording is being listened to

Input Subnet
The IP subnet being listened from

Number of frames to record
This is the number of Art-Net frames to record (not movie frames).

ArtNet Input Enabled
This is essentially the same checkbox that can be found in Config > Preferences > ArtNet & DMX
to enable Art-Net input.

Loop playback at file end
Plays the Art-Net recording continuously until playback is cancelled.

Set Save file
Set the file to record to. When this is set, and Input is enabled, the Record button becomes
available.

Set Playback File
The file to be read from, in order to playback Art-Net. Once this is set and Art-Net input is
disabled, the PlayBack button becomes available.

External Controls

Use the External Control (listed under ‘Recording Commands’): ARTNET_RECORD. 

With this control you can set any of the Art-Net recording parameters. Use Recording Mode to change
whether you’re recording, playing back or neither. Note, you will need to ensure you are in the correct
Art-Net input/output mode, See ARTNET external control (listed under ‘Media Commands’).

Example:
artnet_record StartChan=1 EndChan=13 Universe=3 Subnet=2 ByteRange=2 InputIP=192.168.71.10
InputIPSubnet=255.255.255.0 NumberFramesToRecord=80 SaveFile=C:\Movies\Record\art_test.txt
PlayBackFile=C:\Movies\Record\artnetrec.txt RecordingMode=Idle LoopPlayback=true 

Note: Save and PlayBack files are .txt files.

https://portal.7thsense.one/user-guides/resources/ExternalControlHelp.html
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Using Serial Events for Device Control

Using Serial Events for Device Control

Delta has a range of pre-built serial events for to allow sending out serial codes to external devices at
set times on the timeline and additionally, you can write more complex serial commands within a
Delta Sequence, for example to enable real-time interaction. This document demonstrates how to set
up a projector using serial communications and trigger serial events using both direct and sequence
methods.

Projector Setup

Connect your projectors using (in this example) RS232 or RS422 as required, for serial
communications to the relevant com port (available comports are listed in the Config > Preferences >
Communication > Serial tab).
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Using Serial Events for Device Control

Create Serial Event in Delta Timeline (Direct Method)

You may have some sample serial events already listed in your Delta Resource panel but for this
example of multiple projectors on separate comports, you will need to create a new set of commands
(using copy, paste, edit) for each projector that you want to control from within the timeline.

In the server C:\ drive, open the SerialEvents folder and select an appropriate event to copy/edit:

Serial events are named .7SE files and are written in .xml, so can be edited in Notepad or similar text
editor. Delta relates each serial event to a specific com port, so you must create a new serial event
file for each of the com ports used (whether each port connects a single device or multiple).

The following example of serial event code offers a range of serial commands relating to Christie
Projectors. In the example, several projectors are daisy-chained together from the ‘left’ port, and
others from the ‘right’ port (where left and right simply relate to the positions of the projectors within
space).
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Using Serial Events for Device Control

Remember to edit the RESOURCENAME field to create a unique name for each one, e.g. ‘Left
Projectors’, ‘Right Projectors’, and to save each of the files back into the \SerialEvents folder under
appropriate names (e.g. LeftProjectors.7SE, RightProjectors.7SE).

<?xml version="1.0" encoding="ISO-8859-1"?>
<SERIALEVENT_ARCHIVE>
<COMMENT>Copyright(c) 2006 - 7thSense :
http://www.7thsense.one</COMMENT>
<COMMENT>Roadie 25k, Roadster S, Mirage S, Christie DS,DW,HD, Matrix
3000,4000, DLV1400-DX,DLV1920-DX</COMMENT>
<DATE>08.09.2006 14:20:00</DATE>
<VERSION>1.0</VERSION>
<BETA>Beta</BETA>

<FILENAME>C:\SerialEvents\leftprojectors.7SE</FILENAME>

<RESOURCENAME>Left Projectors</RESOURCENAME>
<SERIALEVENTS>
<CommandCount>7</CommandCount>
<SelectedCommand>0</SelectedCommand>
<InputOutput>Output</InputOutput>
<COMMAND0>
<NAME>Shutter Open Projector 1</NAME>
<DATA>(1SHU 0)</DATA>
</COMMAND0>
<COMMAND1>
<NAME>Shutter Close Projector 1</NAME>
<DATA>(1SHU 1)</DATA>
</COMMAND1>
<COMMAND2>
<NAME>Shutter Open All</NAME>
<DATA>(SHU 0)</DATA>
</COMMAND2>
<COMMAND3>
<NAME>Shutter Close All</NAME>
<DATA>(SHU 1)</DATA>
</COMMAND3>
<COMMAND4>
<NAME>Power On All</NAME>
<DATA>(PWR 1)</DATA>
</COMMAND4>
<COMMAND5>
<NAME>Power Off All</NAME>
<DATA>(PWR 0)</DATA>
</COMMAND5>
<COMMAND6>
<NAME>Select Source 1 All</NAME>
<DATA>(SRC 1)</DATA>
</COMMAND6>
</SERIALEVENTS>
</SERIALEVENT_ARCHIVE>
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Using Serial Events for Device Control

Out of the 7 commands above, some relate to an individual projector [e.g. (1SHU 0)
where the 1 relates to the 1st device on the daisy-chain], whilst other commands will
be sent to the whole set of daisy-chained devices [e.g. (SHU 0)].

Once you have appropriate files stored for each of the COM ports used, refresh the
DeltaGUI, and the new resources will appear under the Serial Events tab. Drag and
drop an event onto the timeline, then simply select the event that you need from the
drop-down menu:

Click the Serial Events tab and select the command that you want to send on this
instance from the drop-down:
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Using Serial Events for Device Control

[Note how the commands above relate to the code shown previously.] The name of
the event on the timeline will now change to reflect this selection.

Your device manual will show whether you need to add a Control Character (such as
Carriage Return) – if the device doesn’t recognise a correct character sequence, it
could ignore the command completely.
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Using Serial Events for Device Control

Configure Projector COM Ports in Delta

In DeltaGUI, open Configure > Preferences > Communications and click on the Serial tab.

Look up the Baud, Parity, Data Bits, Stop Bits for your projectors in the device manuals, then select
accordingly from the drop-down menus that relate to each relevant serial port:

When you run your Delta show, each of your serial events on the timeline will send the selected codes
when the playhead reaches them.
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Trigger Serial Commands on Demand (Sequence Method)

Once a sequence is written, it can be called in the Timeline in just the same way as the set serial
events (as above) or you can call it from the Stack Designer interface (see the user guide: Managing
Delta Servers).

Create a Sequence Event

Sequences can be created to carry out a single command or a series of commands. The following
example shows the single command to open the shutter for ‘Projector 1’.

In DeltaGUI, open the View menu and select Sequence Editor to add a new sequence:
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Using Serial Events for Device Control

The Delta Sequence Command Protocol can be viewed by clicking the Help button at the bottom of
the Sequence Editor window.
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To send serial ASCII commands to external devices, select the SENDASCIISERIAL2 command.

In this example, for a single Christie Projector with RS232 connection, the close shutter command
may be written into the Delta sequence as:

sendasciiserial2 data="(SHU 0)\x0D" port=1 baudrate=9600 parity=n
databits=8 stopbits=1

(SHU 0)\x0D is the shutter close command followed by carriage return (x0D in hex).

See your individual device manual for guidance on its baud rate, data bits and parity.
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(Example taken from TIPM Serial Commands Technical Reference Information – CHRISTIE®, 2010)

This single command could be extended to include further commands to close and open all (3)
projector shutters, for example:
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cue = stop the show and wait for the play command

delay 2s = wait for 2 seconds

play = play the media from the point at which it was stopped
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Note: if your projectors are daisy-chained from a single comport, you can send commands to all or
individual projectors in the chain:

ALL:

sendasciiserial2 data="(SHU 1)\x0D" port=1 baudrate=9600 parity=n databits=8 stopbits=1

1st in chain only:

sendasciiserial2 data="(1SHU 1)\x0D" port=1 baudrate=9600 parity=n databits=8 stopbits=1

See the Sequence Control Protocol (Help button) for many other commands that you
can write for show control and your projector handbook for serial commands that the
device understands.

Once created, sequences can then be dropped on the timeline in a similar way to the
serial events (Direct Method). Select an instance of a sequence, drop it on the timeline
at a point at which you want to trigger it, then right-click for properties and select the
correct sequence for the instance using the Resource Editor.



33

MC258-2 Device Control with DeltaServer : User Guide 
 
                                                                                             © 2024 7thSense

Using Serial Events for Device Control

Alternatively, you can create a Stack Designer page and use buttons/controls to trigger
the sequence on demand.
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For creating Stack Designer web control pages, see the user guide: Managing Delta
Servers.

http://portal.7thsense.one/user-guides/MC255-managing-servers/
http://portal.7thsense.one/user-guides/MC255-managing-servers/
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UDP Serial Events

You will need to create instances of the UDP command for each function and each projector.

· Select the UDP resource in DeltaGUI.

· Drag and drop each UDP command onto the timeline at the predetermined points where you want
to trigger a response

· Double-click the event to access the resource editor (or right-click > Properties):

In the General tab, type a comment for your resource (making sure that it relates to both the function
and component), which will then be displayed as the name of the instance in the timeline.

In the Timeline tab, set the IP address to the IP of the server and the Port number to the unique port
connection to the specific projector:
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Using Serial Events for Device Control

Note: UDP resources should not be set to a time of 00:00:00::00 in the timeline as Delta may skip
over them on startup. It is therefore advisable to set your UDP Timeline Position a few frames in
from the start (if they are to be triggered at the start of a show, with the media set to delay until
projectors are on in this example). Any UDPs that are to trigger later on in the show may be
positioned precisely.

In the Serial Events tab ‘Command Text’, write in the command string that you want to send to that
specific projector:
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Be sure to include the control character (carriage return) as required by your receiving device, at the
end of the command. Control characters are listed in the drop-down menu.

Notes:

The commands that your device (e.g. projector) will understand, should be listed in its own
product/user guide.

Occasionally, some device commands may conflict with Delta’s own: if your UDP command is not
working, try converting the ASCII characters into Hex (e.g. 00PON = 3030504F4E).

Remember, each UDP instance can only send a single command to a single device so you must set
up an instance for each and every command that you want to send, and position them on the timeline
as the exact time that you want each command to be sent.
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PJLink

For devices using PJLink, use the Stack web interface:

Ø PJ Link Control (user guide) 

http://portal.7thsense.one/user-guides/MC255-managing-servers/index.html?sf_pjlink_control.html
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Using 7thUDP2TCP for Device Control

This is an application that can run on startup, and is configured to receive UDP
commands and convert to TCP commands. It is not part of the DeltaServer installation,
so if you need it, please contact support@7thsense.co.uk.

Install as a Windows Startup program

· Copy the application program file 7thUDP2TCP.exe to C:\ProgramFiles\7thsense\Delta\

· Add a shortcut to the program in your Windows Startup:

Windows 7: C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Startup

Windows 10: Locate the hidden Startup folder with Windows+R, and in the Run dialog, type
‘shell:startup’. Leave this window open. Copy the 7thUDP2TCP.exe program file and ‘Paste
shortcut’ in this window, and close.

On startup of the server, the app will automatically enable conversion UDP commands to TCP.

Tell the app which device communications to convert

Open 7thUPD2TCP:

Click Create to add a new I/O configuration and type in any free Input Port number of the server
(make a note of it), then enter the device IP address and its Port number (connecting it to the server):
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Confirm with OK, and add a new record for each TCP device:

Repeat until you have all your device details listed, making note of each of the Input port numbers
that you have used for each device.

Remember that this app needs to run in the background whilst your show is running if you are to
trigger communications with the TCP devices: do not Exit the app.

Note: As you send the command from Delta (whether via sequence or timeline-based UDP
command), you will increment the Packets Rx. The Packets Tx value only increments if the
command is actually sent somewhere.If you need the ability to parse return (such as 00QPW), you
will need to use the HTTP API to parse the feedback: please contact support@7thsense.co.uk for
further advice on this functionality.
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Setup Instructions for 7thSense 3D Sync using Labjack

This section describes the configuration of hardware and software used to synchronize multiple
servers in a 3D application. Information is provided to allow verification of correct operation. It also
describes the additional hardware used to synchronize multiple servers in a 3D application. Wiring
information is provided to allow fault finding if necessary.

Please note: From 2020 7thSense deprecated the terms master and slave for the dependencies
between devices. We now refer throughout to ‘Leader’ and ‘Follower’ in our products.

To maintain functionality, both terminologies continue to work internally, but our documentation no
longer uses the former terms. Users of pre-2020 products will need to observe the equivalence and
continue to use the previous legacy terms.
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Hardware Connectivity

USB cable: Connect between USB ports on the LabJack unit and the Leader server.

LabJack 3D Sync Cable Assembly

· 15-way D Plug connects to the LabJack unit.

· Mini-DIN plug marked ‘M’ to the Leader server graphics card’s 3D sync connector.

· Mini-DIN plug marked ‘S’ to the Follower server graphics card’s 3D sync connector. Where more
than 1 Follower server is in use, the Mini-DIN plug marked ‘S1’ goes to the 1st Follower server
graphics card’s 3D sync connector, the Mini-DIN plug marked ‘S2’ to the 2nd Follower server, and
so on.

· BNC plug to the 3D glasses emitter or projector, as required.
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Software Configuration

On the Leader Server, open the ‘7thSense – 3D Sync Fix’ Application. This should be running in the
taskbar in the bottom right of the Windows desktop (small blue triangle icon with ‘SD’ in centre).

If this application is not running in the taskbar, open the location:
C:\Program Files\7thSense\Delta\Utilities

Create a shortcut for ‘7th3DSync.exe’ and put this shortcut in the following location:
C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Startup

In the 7thSense – 3D Sync Fix application (see DeltaGUI below), please check the following:

1. LabJack Initialised OK checkbox should be ticked (this means it has detected the LabJack unit).

2. Which LabJack port? should be set to ‘EIO’ if using the LabJack’s 15pin D-Sub connector
(otherwise set to ‘FIO’ if stereo sync signals are connected to the terminals on the sides of the
LabJack).

3. Delta UDP port should be set to match the UDP port for communicating with the Follower server.
You can check this by navigation to Preferences > EDIT > Communication on server.exe on the
Follower, or by selecting the Follower in DeltaGUI and navigating to Configure > Preferences >
Communication > Ethernet (in DeltaGUI). In either of these locations, you should see the UDP port
value (7780 by default) (see Server Configuration, DeltaGUI below).

4. Heartbeat enable should be checked.

5. Delta Server Followers: Enter the IP addresses of the Followers with which you want the 3DSync
app to sync. Enter the IP address of the 1st Follower server in the top line, if you only have one
Follower ignore the other lines. If there are 2 or more Follower units, their IP addresses should be
entered in order below the IP address for the 1st Follower server.
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Click Apply and then OK at the bottom of the screen.

Note: Do not click Exit as this app needs to run in the background.

Restart the server application on both the Leader and the Follower(s).

· Open DeltaServer.

· Click Preferences > Edit to open the Server Configuration screen:

· Click ‘Communication’ and check to ensure that the Telnet Port (UDP) matches the Delta UDP
Port number (as set in step 3 above)

· Repeat for each Leader/Follower server:
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Verifying Operation

Once the server application has restarted, reopen the 3DSync fix application.

Check that the ‘Level’ column next to the Leader and Follower(s) is changing intermittently. If either
of the ‘Level’ indicators are stuck at ‘0’ or ‘1’ then confirm that the relevant server is operating in a
stereo mode and that the LabJack cable assembly is connected to that server as detailed above.

Each Follower Server will be operating in one of 2 modes, either in phase or out of phase with the
Leader Server, this can be verified by looking at the 3DSync fix DeltaGUI and the stats on the Follower
server playback window (see illustration below). To view stats on Playback, press S on the Follower
keyboard or select ‘Show Stats’ from the DeltaGUI toolbar. The mode in use will be apparent as
follows:

Leader and Follower Server in phase

· Leader and Follower Levels: Either simultaneously ‘1’ and ‘1’ or ‘0’ and ‘0’.

· Follower ‘Inverted’ checkbox unticked.

· Follower stats will not indicate ‘Stereo eyes swapped’.

Leader and Follower Server out of phase

· Leader and Follower Levels: Either simultaneously ‘0’ and ‘1’ or ‘1’ and ‘0’.

· Follower ‘Inverted’ checkbox ticked.

· Follower stats will indicate ‘Stereo eyes swapped’.

Where there are multiple Follower servers each Follower Server will have its own phase relationship
with the Leader Server. So some Follower servers may be in phase with the Leader server and some
out of phase.

The following timing diagrams illustrate these modes:

Leader and Follower Server in phase
(Follower ‘Inverted’ checkbox unticked)
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Leader and Follower Server out of phase
(Follower ‘Inverted’ checkbox ticked)

When the Inverted checkbox is ticked in the 3DSyncFix screen, you will also see the Stereo Eyes
Swapped statement in the playback window statistics (press S on the keyboard whilst in the Playback
Window) as shown below.
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LabJack 7thSense Pinout and Connections

Parts Required

· LabJack Package. Containing:

o LabJack U3-LV

o USB cable (1.8m)

· LabJack 3D Sync Cable Assembly. A 15-way D plug terminated with cables to:

o 3 pin Mini-DIN plugs - 1 cable for the Leader server, 1 for each Follower server.

o BNC plug - Cable to 3D glasses emitter/projector

The default length for each cable is 1m.

15 pin D Plug mating face

3 pin Mini-DIN Plug mating face

Wiring Information

USB cable: Connect between USB ports on the LabJack unit and the Leader server.

LabJack 3D Sync Cable Assembly (Leader and Single Follower Server)

· 15 Way D Plug connects to the LabJack unit.

· Mini-DIN plug marked ‘M’ to the Leader server graphics card’s 3D sync connector.
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· Mini-DIN plug marked ‘S’ to the Follower server graphics card’s 3D sync connector.

· BNC plug to the 3D glasses emitter or projector as required.

Signals (Leader and Single Follower Server)

Signal
Leader Server
3 pin Mini-DIN

Follower Server
3 pin Mini-DIN

LabJack
15-way D

3D glasses emitter
BNC

Leader Sync Pin 3 No Connection Pin 4 Centre Pin

Follower Sync No Connection Pin 3 Pin 12 No Connection

Gnd Pin 2 Pin 2 Pin 8 Outer Shell

Leader and 2 or More Follower Servers

Additional servers are connected from Pin 3 of their 3 pin Mini-DIN connector to the appropriate
LabJack 15-way D connector pin: 

Signal
LabJack
15-way D

Follower Server
3 pin Mini-DIN marking

Follower 1 Sync Pin 12 (EIO1) S1

Follower 2 Sync Pin 5 (EIO2) S2

Follower 3 Sync Pin 13 (EIO3) S3

Follower 4 Sync Pin 6 (EIO4) S4

All Gnd signals are connected from the Follower Server 3 pin Mini-DIN plugs pin 2 to the LabJack 15-
way D connector pin 8.
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DeltaShowControlInterface

DeltaShowControlInterface is a small utility that provides a control logic for the Advantech ADAM-
6060 interface module so that Delta shows can be controlled from simple remote switches. A ‘dry’
digital input (switch or pulse) to the ADAM-6060 will send a UDP trigger over Ethernet to the IP of the
required Delta Server to either perform a simple timeline command or trigger a Delta sequence.

There are two Control Logic modes , one to operate simple load/loop/stop timeline commands, the
other to trigger prenamed Delta sequences. Any sequence can be written in Delta under a name that
belongs to each input switch.

The Advantech ADAM-6060 illustrated here is a data acquisition and control module with 6 channels
of digital input and 6 channels of relay outputs using Modbus TCP over Ethernet. Please refer to the
specification of this unit for full details and suitability. Use the Advantech .NET utility supplied with
your unit or downloaded from Advantech. Please refer also to the manual supplied with your
Advantech ADAM-6060 unit.

Ø Advantech ADAM-6000 series User Manual (2018) 

Required Components

· DeltaShowControlInterface Software v.1.0

· Advantech ADAM-6060 Interface Unit + Ethernet cable

· Adam/Apax .NET Utility

Principle

The Advantech ADAM-6060 converts digital inputs to output commands over Ethernet.

DeltaShowControlInterface provides a control logic to convert this output to meaningful DeltaServer
commands.

The Adam/Apax .NET utility enables communication between the ADAM-6060 and the Delta
playback server.

The DeltaShowControlInterface configuration .xml file enables communication between the
DeltaShowControlInterface utility and the DeltaServer application.

Combination switch operations into the ADAM-6060 are interpreted as playback controls, or
instructions to run specifically-named sequences.

DeltaShowControlInterface section revised July 2020.

60

http://advdownload.advantech.com/productfile/Downloadfile4/1-1M99LTH/ADAM-6000_User_Manaul_Ed_9.pdf
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Workflow

1. Install DeltaShowControlInterface software on the Delta Server or another networked PC where
you wish to use it.

2. Connect the Advantech ADAM-6060 to the server Ethernet network.*

3. Connect and switch on the power supply.

4. Install and run the Adam/Apax .NET utility on the Delta server playing the shows to be controlled.

5. Configure the ADAM-6060 comms  so that the Delta server and the ADAM-6060 talk to each
other.

6. Connect the switches to be used with the Digital Inputs on the ADAM-6060:*

53
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7. Configure DeltaShowControlInterface so that DeltaServer communicates with it.

8. In DeltaGUI, configure the Delta show(s) to communicate with DeltaShowControlInterface, and/or
create sequences with the sequential names that are integral to DeltaShowControlInterface.
Which of these two modes is used is set in the Control Logic  of DeltaShowControlInterface.

* Note. The Advantech ADAM-6060 is a very versatile unit being used in a very specific way with
the DeltaShowControlInterface utility to provide simple show control switching for Delta servers
using the digital inputs.

Shown here are connections that include the relay outputs. It is also possible to send ASCIIUDP
from a Delta sequence to operate a relay switch for other equipment. This does not require the
DeltaShowControlInterface. See Appendix: Sending ASCII to ADAM-6060 .

60

63
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Configure the ADAM-6060 Comms

Open the Adam/Apax .NET Utility and configure the communications between the Delta server
playing the show and the ADAM-6060 receiving the switch signals.

Note: Some parts of configuration use a password. The default is eight zeros: 00000000.

Identify the Delta server NIC (IP) to receive the control from the ADAM-6060 (example:
10.100.101.174) and click on it.
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From the top menu, click on Tools > Search to find the connect ADAM-6060 module:

This will find the unit. Click on it to show the configuration tabs:
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Select the Network tab and note or change the ADAM-6060 IP address as required (example:
10.100.101.179). The ADAM-6060 must be on the same subnet range as the Delta server.
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Select the Stream tab, where the module IP address needs to be a Host to receive data:
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Next go to the Access Control tab, where the ADAM-6060 IP address and that of the Delta server it
links to, should be listed and enabled:

In the Password tab, the default password of 00000000 (eight zeros) can be changed, but for our
purposes here, there is no need to do so.
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Go to the Information tab and Save the configuration:

The ADAM unit is now configured to communicate with the Delta PC.

Close the Adam/Apax .NET utility.
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Configure DeltaShowControlInterface

Open the DeltaShowControlInterface software. This will link its control logic with DeltaServer.

ADAM-6060

· In the ‘My IP address’ box, type in the IP address of the Delta server (or other PC) on which you
are currently using the DeltaShowControlInterface.

· Click the ‘Set’ button on the right. You should now see the checkbox ticked to show you are
connected to the Delta port to receive the ADAM-6060 commands.

Delta

· In the Delta ‘IP Address’ box, type in the IP address of the Delta Server playing the show (this can
be the same as above), and press the ‘Set’ button on the right. If DeltaServer is currently running,
you should now see the ‘Connected’ checkbox ticked.

· Type the file names of your Delta shows into the ‘Shows’ box. Up to 8 can be added. The names
Shows1-6 are used here just for example.

· Press the Set button to save the newly-typed show names.

Press the hide button to minimise it to the system tray.
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Control Logic for Direct Control (Mode=0)

DeltaShowControlInterface has a configuration xml file:

C:\7thSense\Software & Drivers\Delta\Utilities\DeltaShowControlInterface.xml

which features a Mode switch. When set to Mode=0, it will use Delta load, loop, and stop timeline
commands. When set to Mode=1, it will trigger Delta sequences. For clarity, the connection for the
DeltaShowControlInterface server (or PC) is shown in green, the Delta server (playback) in orange,
and the mode is in red. The Shows section is populated when DeltaShowControlInterface show
names are added.

<?xml version="1.0" encoding="ISO-8859-1"?>
<DELTA_SHOWCONTROL_INTERFACE_CONFIG>
<COMMENT>Copyright(c) 2010 - 7thSense Design Ltd.  : 
DeltaShowControlInterface</COMMENT>
<DATE>28.11.2018  17:8:12</DATE>
<VERSION>3516868</VERSION>
<WINDOW>
<MinimiseOnStart>0</MinimiseOnStart>
</WINDOW>

<DIGITAL_INPUT>
<MyIP>10.100.101.174</MyIP>
<AdamPort>5168</AdamPort>

</DIGITAL_INPUT>

<DELTA_ETHERNET>
<IP>10.100.101.174</IP>
<Port>23</Port>

</DELTA_ETHERNET>
<DELTA_SHOWS>
<Shows>Show1
Show2
Show3
Show4
Show5
Show6
Show7
Show8
</Shows>
</DELTA_SHOWS>

<MODE_OF_OPERATION>
<Mode>0</Mode>

</MODE_OF_OPERATION>
</DELTA_SHOWCONTROL_INTERFACE_CONFIG>
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Mode=0, Direct Show Control

The software control is configured using the logic table (DI = digital inputs) below:

DI 0 (pulsed) = load show

DI 1 (pulsed) = stop show

DI 2 (on) = loop show

DI 3-5 (on) = show selection

Note: P = Pulsed

Which show (up to 8) is addressed depends on the binary array of DI 3 to DI 5:

Input no. DI 0 DI 1 DI 2 DI 3 DI 4 DI 5

Stop Show P

Loop Show On

Load Show 1 P

Load Show 2 P On

Load Show 3 P On

Load Show 4 P On On

Load Show 5 P On

Load Show 6 P On On

Load Show 7 P On On

Load Show 8 P On On On

Enabling the show to listen to show control

To use this mode requires adding a ‘Stop’ and a ‘Loop’ Control resource to each show that is to be
controlled:
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Control Logic for Sequences (Mode=1)

Delta sequences can be written and saved to the filenames shown below. The name is addressed
and the sequence is run.

The software control is configured using this logic table (DI = digital inputs):

DI 0 (pulsed) = load sequence “digitalinput_b0_s1” (on)

= load sequence “digitalinput_b0_s0” (off)

DI 1 (pulsed) = load sequence “digitalinput_b1_s1” (on)

= load sequence “digitalinput_b1_s0” (off)

DI 2 (pulsed) = load sequence “digitalinput_b2_s1” (on)

= load sequence “digitalinput_b2_s0” (off)

DI 3 (pulsed) = load sequence “digitalinput_b3_s1” (on)

= load sequence “digitalinput_b3_s0” (off)

DI 4 (pulsed) = load sequence “digitalinput_b4_s1” (on)

= load sequence “digitalinput_b4_s0” (off)

DI 5 (pulsed) = load sequence “digitalinput_b5_s1” (on)

= load sequence “digitalinput_b5_s0” (off)
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Appendix: Sending ASCII to ADAM-6060

It is also possible to send an ASCII UDP command to an Advantech ADAM-6060 to address a relay
output.

This is not part of DeltaShowControlInterface.

A typical string would be:

SENDASCIIUDP [IP_Address] [Port] [ASCII_Command]\x0D

Example:

SENDASCIIUDP 10.100.101.179 1025 #011001\x0D

#01 identifies that we are addressing an ADAM-6000 series device.

10 is which of the 6 channels (relay outputs) to address: the first digit should always be 1, the second
digit is the channel 0-5 (base 0), so ‘channel 4’ is 13.

01 is the on/off trigger: 00 = Off; 01 = On

\x0D is the carriage return to send the command
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